Table of Contents

1. **Overview** .................................................................................................................4
   Welcome to Perception Neuron...................................................................................4

2. **QuickStart** .................................................................................................................5
   2.1 Equipment Introduction.......................................................................................5
   2.2 Capturing Motion Data.......................................................................................6
   2.3 Caution & Tips......................................................................................................10

3. **Software Interface Introduction** ............................................................................12
   3.1 Interface Layout ..................................................................................................12
   3.2 Menu Bar ............................................................................................................13
   3.2.1 File ................................................................................................................13
   3.2.2 Window ..........................................................................................................17
   3.2.3 Tool ...............................................................................................................24
   3.2.4 Help ...............................................................................................................25

4. **Connection and Calibration** ..................................................................................26
   4.1 USB Connection .................................................................................................26
   4.2 Wireless connection ............................................................................................28
   4.3 Multiple Equipment Connection ........................................................................31
   4.4 Model Posture Calibration ..................................................................................31

5. **Sensor Wearing Combination Mode** ....................................................................36
   5.1 Wearomg Combination Mode Introduction .......................................................36
   5.1.1 Full Body Mode .............................................................................................37
   5.1.2 Single arm mode ............................................................................................39
   5.1.3 Upper Body Mode ..........................................................................................40
   5.1.4 Lower Body Mode ..........................................................................................42
   5.2 Standby Device ...................................................................................................42
   5.3 Attention ..............................................................................................................46

6. **Data Editing** .........................................................................................................47
   6.1 Model Alignment .................................................................................................47
   6.2 Body Size Manager ..............................................................................................48
   6.3 Parameters ...........................................................................................................51
   6.4 Smooth Factor .....................................................................................................53
   6.5 Data Visualizer ....................................................................................................54
7. Offline Recording and Prop Function ............................................. 64
   7.1 Offline recording ........................................................................ 64
      7.1.1 Status Definition ..................................................................... 64
      7.1.2 Turn into Offline Mode ............................................................ 64
      7.1.3 Calibrate and Record ............................................................... 64
      7.1.4 Stop Record ........................................................................... 65
   7.2 Offline Data Import ...................................................................... 65
   7.3 Prop Function ............................................................................. 68

8. File Export and Data Transmission .................................................... 73
   8.1 File export .................................................................................. 73
      8.1.1 BVH file export ....................................................................... 73
      8.1.2 FBX file export ....................................................................... 74
      8.1.3 3ds max biped file export ....................................................... 75
      8.1.4 Calculation File Export ............................................................ 76
      8.1.5 High-precision BVH file export ............................................. 77
      8.1.6 Multi-actor file export ............................................................. 78
   8.2 Data transmission ...................................................................... 79
      8.2.1 BVH ....................................................................................... 80
      8.2.2 Action .................................................................................... 83
      8.2.3 Calculation ............................................................................. 84
      8.2.4 IP selected ............................................................................. 86

9. Equipment Maintenance ................................................................. 91
   9.1 Device Firmware upgrade ............................................................. 91
   9.2 Neuron calibration ..................................................................... 96

10. Appendix ...................................................................................... 104
Welcome to Perception Neuron

PERCEPTION NEURON is the world’s most versatile, adaptable, and affordable motion capture system; it offers user-friendly technology for various applications. PERCEPTION NEURON offers a flexible motion capture solution in the fields of VFX, game interaction, virtual reality, sports analysis, medical analysis, real-time stage performance, and many more.

1. VFX: Motion recording and playback; Output formats include BVH and FBX supported in Maya, MotionBuilder, Blender, and most other industry-standard 3D animation applications.

2. VR / Game interaction: Seamless integration with opensource game engine demos running on standard HMDs, gesture control library included. Bring 'yourself' into the virtual world.


2. QuickStart

Perception Neuron motion capture system communicates with the Axis Neuron software application. Axis Neuron receives and processes the motion data that can then be exported to third-party software. Perception Neuron and Axis Neuron can be synchronously connected with third-party software applications such as Unity, Maya, and MotionBuilder. This pipeline gives you high-quality motion data compatible with most professional movie effects and game development tools.
Are you ready? The following content is designed to quickly get you up and running with Axis Neuron.

### 2.1 Equipment Introduction

<table>
<thead>
<tr>
<th>Neuron Sensor</th>
<th>Hub</th>
<th>Strap</th>
</tr>
</thead>
<tbody>
<tr>
<td>An IMU (Inertial Measurement Unit) composed of a gyroscope, accelerometer, and magnetometer.</td>
<td>The hub collects the motion data from the Neuron Sensors. It then sends the data to the computer via USB or wireless connectivity.</td>
<td>The straps secure the Neuron Sensors to the body. The label on the back specifies the location of the strap.</td>
</tr>
</tbody>
</table>

If you need to get started immediately, the quickstart tutorial can be accessed from the reference below.
Quickstart Tutorial:
2.2 Capturing Motion Data

After properly fitting the straps and sensors, launch the Axis Neuron Software and we can begin recording motion data.

1. Connect the Hub to the computer with the USB data cable (Black). One side of the USB cable connects to the Hub’s Data port and the other side connects to an open USB port on the computer.

2. When the hub is recognized successfully, the ID of the hub will display on the left panel of the Welcome window. Click the Connect button to connect the hub with the computer.
3. After successfully establishing a connection with the hub, click the zero button to center the model to the origin. (Please remain steady during this step)

4. Model sizes can be chosen in the Body Dimension list to ensure a more accurate experience.
5. Click the **Calibrate** button to do the pose calibration. Calibration helps orient the sensors to help accurately capture the motion data.

6. Check the pose(s) that needs to be calibrated and then click the **Next** button to start.
7. You can start recording after completing pose calibration. Click the Record button to begin. Then choose where to save the data and set the File name in the pop up window. (The motion is then recorded when the Record button blinks)

8. You can stop recording by clicking the Record button again. The recorded file will then appear automatically in the Working Directory window.

9. To play the recording, select the recorded file generated in the Working Directory window and click the Play button.
10. You can export your data by clicking **File->Export->Export Settings**, and then click the **Export** button to export your data to default <bvh> format.

![Image](https://neuronmocap.com)

### 2.3 Caution & Tips

1. **Environment** - It is strongly suggested to use your Perception Neuron system in an environment with little to no magnetic field. Otherwise the sensors will be adversely influenced and can make the motion captured data extremely imprecise. Avoid electric motors, loudspeakers, transformers, and Iron furniture when using Perception Neuron.

---

**PREPARE YOUR WORKING ENVIRONMENT**

**KEEP AWAY FROM MAGNETIC SOURCES.**

PERCEPTION NEURON® should not be used in an environment with strong magnetic interference. Using the system in such an environment introduces significant errors to the motion capture results. Exposing Neurons to such an environment for an extended period will cause sensor magnetization.
2. Improving Precision - Accurate skeletal measurement and size can improve the precision of the motion data; to do so, measure your actor’s specified body parts and input this data into the **Body Size Manager** before recording. How to measure will be introduced later.

3. Highly accurate body size can improve the quality of motion data. You can find the method of body measurement in **6.7 Body Size Measurement**.
3. Software Interface Introduction

3.1 Interface Layout

1. Menu bar – File, Window, Tools, and Help access.
2. Title – Displays the name of opened file.
3. Sensor Map – Displays the data transmission signal strength from the sensors.
4. Scene View Navigation – Contains controls for navigating and displaying scene elements.
5. Motion Capture Bar – Contains controls for connecting/disconnecting, recording, and calibrating the sensors.
7. Contact Editing – Displays contact points for a given capture sequence.
8. Range Settings – Sets the frame range for a given capture session.
9. Play Controller - Basic controls for sequence playback.
10. Working Directory – Displays a list of captured files from a user specified folder.
11. Status Bar – Displays the current status of system.
12. This area contains multiple parameter tabs utilized during the capture and cleaning process.
13. Prop settings – Contains controls for adjusting the pose of prop and its contact point.
Interface Tips:

1. You can show or hide any panel in Window -> Panels or you can right click the title bar of any panel and then check the panel that you want to see.

2. The current layout can be reset in Window -> Layout. There are several default layouts available.

3. You can move panels anywhere by dragging the title bar of the panel. Additionally, double clicking the title bar of a panel will toggle the panel between floating mode and docking mode.

3.2 Menu Bar

3.2.1 File

Options available include Open File, Open Directory, Recent File, Recent Directory, Settings, Export, and Exit.

1. Open File: Opens an existing file (.raw format).
2. Open Directory: Displays files from a folder location.
3. Recent File & Recent Directory display recently opened files and folders.
4. Settings:

- General: Displays the Host IP and Port.

- Output Format (important setting):
  - Displacement: checking this box will affect the real-time model, the Data Visualizer panel, and the real-time data broadcast. Some third-party software (like 3ds max) does not support bone displacement. In order to play the data in this kind of software, you have to uncheck the Displacement option before outputting data. However, the legs will appear to not be straight because no displacement data is outputed.
Advanced:

- **Contact Optimization Level:** This system calculates auto-optimization on the original contact relationship data. The default value is 2.

- **Gyro Mode:**
  
  - **Auto detect:** According to different magnetic field environments, this option will automatically adjust the working mode (9-Axis or 6-Axis) to the appropriate one. When the system detects a high-intensity magnetic field, the LEDs of the Neuron sensors will always be on and the gyro will switch to 6-Axis mode. It will not calculate the magnetic data to ensure that the motion capture data will not be influenced by the high-intensity magnetic field. When the actor moves to a low-intensity magnetic field environment, the gyro will switch back to 9-Axis mode and the LEDs of the Neuron sensors will be back in their normal state again.
  
  - **9 axis/6 axis:** Manual mode. You can adjust the gyro mode manually by choosing 6 or 9 axis.
5. **Export Settings:** Provides options for exporting data from Axis Neuron.

- **Rotation:** The rotation order of the Euler angle. The default order is YXZ. This is only for exporting to BVH or 3ds max format.
- **Displacement:** Determines if the exported file contains displacement data.
- **Character List:** You can choose which character(s) to export when working in Multiplay Mode.
3.2.2 Window

The layout can be adjusted through this menu and panels can be shown or hidden.

Layout - There are several layouts that you can choose. They are **Full Function mode, Editing mode, Capture mode, Replay, and Demo mode**. Additionally, you can make a custom layout by choosing **New Layout**.

- Full Function – Displays all windows needed for recording and editing.
- Editing layout – Similar to Full Function with slightly different window space configuration.

- Capture layout – Closes the Contact Editing window as this is not needed during the capture phase.
Replay and Demo – Maximizes the Workspace window’s screen space.

Panels - Show or hide specific panels.
Motion Capture Toolbar - Show or hide the Motion Capture Toolbar. Following are descriptions of the operations available in the Motion Capture Toolbar.

- **Record**: When this button is clicked, the Record settings dialog will popup. You can change the storage path and file name here. When you click "Ok", the red light will blink and recording will start. Click "Record" again and the recording will stop. The new raw file will show in the Working Directory.

- **Connect**: Before you start recording, you need to connect the suit to the Axis Neuron software. Once you click this button, you can choose the device you want to connect from the equipment list. Multiple devices (suits) will be available if you are using more than one suit.

- **Disconnect**: Clicking this button will disconnect the device(s) and the Axis Neuron software.

- **Calibrate**: This button will start the pose calibration process to improve capture accuracy.

- **Eliminate error**: This button will align the actor with the origin of the Workspace. When the sensors capture a lot of out-of-range motions, the sensor accuracy may become imprecise. Click Zero to minimize those errors. After clicking the button, the Keep Steady radar will display and the actor should remain steady during this period.
Shutter: Shutter is the remote controller. Clicking this button will open the shutter function. Clicking it again will close this function. Before using shutter, please plug the receiver into an open USB port.

The red button means **Record**.

The R button means **Calibrate**.

The L button means **Eliminate error**.

Scene View Toolbar: Switches the scene view.
View – Various viewport layouts can be chosen from here. Each view can show any angle of the model. When setting multiple views, you can drag the separation line of two views to resize them.

- The shortcut for full screen is Ctrl+F. Quit full screen is Ctrl+F or Esc.
- Click with the left mouse button on the view that you want to be active. Press and hold the left mouse button will move the camera view (pan). Press and hold the right mouse button will rotate the camera view (orbit). Rolling the mouse wheel will adjust the distance between the camera and the model (dolly).

- Background: Shows the floor.

- Camera Track: Makes the Camera follow the model. With this button active, the model will always stay centered on the screen.
- **Center of Mass:** Shows or hides the center-of-mass for the model.

- **Shadow:** Shows or hides the shadow of model.
• Origin Marker: Shows or hides the red cross marker indicating the origin of scene.

3.2.3 Tool

Calibrate Sensor: Calibrates the magnetized neuron sensors to eliminate accumulated errors. This operation requires that the tool cable is plugged into the hub and that the hub is connected to the computer via USB.

1. Upgrade: Firmware upgrade. You can manually upgrade the Hub app, Hub boot, Neuron app, or Neuron boot to the latest version. The system will always auto check the version of firmware as well.

Tips:
• Details on the calibration process can be found in 10.2 Neuron calibration.
• The difference between Pose Calibration and Sensor Calibration:
  a) Pose Calibration: This calibration is for holistic posture when an actor is wearing the equipment.
  b) Sensor Calibration: This calibration is used to eliminate the accumulated error of the single magnetized sensor.
3.2.4 Help

1. Open Folder: Opens the Body Size Files or Demo Files folder.

2. Reset: Contains options for resetting various parameter categories.
   - Settings: Reset all setting to their default.
   - Layout: Reset the layout.

3. Working Mode Reference Diagram: Provides a visual reference to the motion capture wearing modes.
4. Connection and Calibration

The Neuron Sensors are capable of 60/120 fps sampling rate. All of the sensor will send the data to the Hub and the Hub will send the data to the computer via USB or Wireless connectivity. This chapter will outline these two methods of connection and pose calibration.

Note: 18 nodes and above have a max sample rate of 60 fps. Less than 18 nodes will use 120 fps sampling rate.

### 4.1 USB Connection

There are 2 ways to establish a connection via USB.

1. **Method One:** Using the Connect button in the Motion Capture toolbar and choosing the device from the Equipment list window.
   a) Plug the USB cable into the Hub using the Data port connection and connect the other side of the USB cable into an available USB port on the computer.
   b) Click the Connect button in the Motion Capture toolbar.
c) Click **Connect** in the Equipment list popup window.

![](https://neuronmocap.com)

2. **Method Two: Using the Connect button in Welcome window.**
   a) Plug the USB cable into the Hub using the Data port connection and connect the other side of the USB cable into an available USB port on the computer.
   b) Click Window ->Welcome, and click **Connect** at left side.
Note: When you create a real-time connection, the sensor map will show the transmission quality of the data.

4.2 Wireless connection

Axis Neuron uses the Hub to establish a connection with the router. Neuron supports any standard 2.4G wireless router.

1. Set up your router: Set the router’s SSID and password. (The length of SSID needs to be less than 26 characters. The length of the password needs to be less than 17 characters.)
2. Connect the computer to the router via an Ethernet cable.
3. Plug the USB cable into the Hub using the Data port connection and connect the other side of the USB cable into an available USB port on the computer.
4. Click the Connect button in Motion Capture toolbar.
5. Click **Setup** in the Equipment list

6. Click **Next**

7. Click the SSID you want to connect, and input the password.
8. Unplug the USB data cable from the computer. Switch the USB cable attached to the Hub from the Data port on the Hub to the 5V/2A IN port on the Hub then connect the other end of the USB cable a portable USB power supply. Click Finish to close dialog. Wait until the hub establishes a connection with the router. This should not take more than 20 seconds. The Hub will send out a buzzing sound one time to show a successful connection.

9. Click Connect button.

TIPS:
- If the SSID you want to connect is not in the list, click Refresh SSID button to refresh it. Or you can click the Manual input button to input the SSID manually.
- The Hub will store the SSID and password you set. So, if the Host IP doesn’t change, you can skip setting the password step by clicking the Skip button.
4.3 Multiple Equipment Connection

Axis Neuron supports up to five Neuron suits connect simultaneously. The method of connection is the same as the single equipment connection. They just need to be connected one by one.

4.4 Model Posture Calibration

This four-step calibration process is required before you start recording motion data. Please read the following introduction about how to correctly calibrate the model. You can also find it in the Quick start guide.

**THE FOUR-STEP CALIBRATION**

A FOUR-STEP CALIBRATION procedure is needed before the motion capture session.

1. Steady pose
   - For Steady pose calibration, it is required to keep all sensors as steady as possible (no special requirement to the posture). Try to sit down, put your hands on a table or even take off the whole set of straps / gloves and put it on the ground if you have difficulty to keep steady during this calibration. You only need to do this calibration once until you recalibrate the Neurons on your body straps / gloves as this calibration removes the bias error bring by the connection between Neurons and the socket.

2. A pose
   - For A pose calibration, it is required to stand straight, make sure your arms are pointing down and your palms are facing to your body. The feet should be parallel to each other.

3. T pose
   - For T pose calibration, it is required to stand straight, make sure your arms are in the same height and your palms are facing down. The feet should be parallel to each other. If you are using your gloves with finger straps, make sure your thumb and other four fingers are in the right posture as shown in the diagram.

4. S pose
   - For S pose calibration, crouching down, make sure your legs are not open or close. The feet should be parallel to each other. Make sure your arms are in the same height and the palms are facing down.

1. After connecting successfully, click the Calibrate button in Motion Capture toolbar.
2. Click the Next button in the Posture selection dialog. Then do the Steady, A, T, S pose in turn. (Every posture will have 3-5 seconds countdown, the sound of each countdown and calibration warning tone is different.)
3. When Steady-Pose calibrating, the actor needs to be steady. A sitting position is recommended.

4. When A-Pose calibrating, the actor needs to keep steady in the five second countdown.
5. Following are the T-pose and S-pose calibration, after completing the four-step pose calibration, if the posture is not deemed accurate enough, you can perform another calibration test. When doing a second calibration, you do not need to calibrate the Steady pose again if you didn’t change equipment.
Notes:

1. When the working mode is **Single arm** or **Upper** mode, the S pose is not required. When the mode is Lower body, the T pose calibration is not required.
2. If you change Body size, you need to recalibrate.

3. When wearing the gloves, to do T pose calibration, pay attention to position the thumb at a 45 degree angle from your palm in the top view and left view.

4. When doing steady pose calibration, you don’t have to be wearing the equipment. You simply must keep the sensors steady. Otherwise Axis Neuron will show an error hint. If you see a red spot, this means that Neuron’s steady pose calibration failed. You can click Retry to recalibrate it.
5. Sensor Wearing Combination Mode

5.1 Wearomg Combination Mode Introduction

If you only need to capture a certain part of the body, then you only need to connect the specific parts needed and if you can tolerate lower accuracy levels, then you only need to connect the most basic sensor.
### 5.1.1 Full Body Mode

Full body (Required Sensors: Both sides - upper arm and lower arm, Hip, Spine, both legs' upper leg and lower leg.)

<table>
<thead>
<tr>
<th>Full body</th>
<th>17-Neurons</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hub</td>
</tr>
<tr>
<td></td>
<td>USB cable</td>
</tr>
<tr>
<td></td>
<td>Body straps</td>
</tr>
<tr>
<td></td>
<td>Gloves</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Full Body" /></td>
</tr>
<tr>
<td>Full body (Double hands and fingers)</td>
<td>31-Neurons</td>
</tr>
<tr>
<td></td>
<td>Hub</td>
</tr>
<tr>
<td></td>
<td>USB cable</td>
</tr>
<tr>
<td></td>
<td>Body straps</td>
</tr>
<tr>
<td></td>
<td>Gloves</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Full Body" /></td>
</tr>
<tr>
<td>Full body (one hand, all fingers)</td>
<td>21-Neurons</td>
</tr>
<tr>
<td></td>
<td>Hub</td>
</tr>
<tr>
<td></td>
<td>USB cable</td>
</tr>
<tr>
<td></td>
<td>Body straps</td>
</tr>
<tr>
<td></td>
<td>Gloves</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Full Body" /></td>
</tr>
<tr>
<td>Full body (no palm)</td>
<td>11-Neuron</td>
</tr>
<tr>
<td></td>
<td>Hub</td>
</tr>
<tr>
<td></td>
<td>USB cable</td>
</tr>
<tr>
<td></td>
<td>Body straps</td>
</tr>
<tr>
<td></td>
<td>Gloves</td>
</tr>
<tr>
<td></td>
<td><img src="image4.png" alt="Full Body" /></td>
</tr>
</tbody>
</table>
### 5.1.2 Single arm mode

Single arm (Required sensors: Both sides - upper arm and lower arm.)

<table>
<thead>
<tr>
<th>Single arm</th>
<th>3-Neurons Hub USB cable Dual pogo-pin cable/Body straps Gloves</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="https://neuronmocap.com" alt="Diagram" /></td>
</tr>
<tr>
<td>Single arm</td>
<td>10-Neurons Hub USB cable Dual pogo-pin cable/Body straps Gloves</td>
</tr>
<tr>
<td></td>
<td><img src="https://neuronmocap.com" alt="Diagram" /></td>
</tr>
<tr>
<td>Single arm</td>
<td>9-Neurons Hub USB cable Dual pogo-pin cable/Body straps Gloves</td>
</tr>
<tr>
<td></td>
<td><img src="https://neuronmocap.com" alt="Diagram" /></td>
</tr>
<tr>
<td>Single arm</td>
<td>6-Neurons Hub USB cable Dual pogo-pin cable/Body straps Gloves</td>
</tr>
<tr>
<td></td>
<td><img src="https://neuronmocap.com" alt="Diagram" /></td>
</tr>
</tbody>
</table>
### 5.1.3 Upper Body Mode

Upper body（Required sensors: Both sides - upper arm and lower arm, hip, spine）

| Upper body      | 11-Neurons Hub
|                 | USB cable
|                 | Body straps
| Upper body (all fingers) | 25-Neurons Hub
|                 | USB cable
|                 | Body straps
|                 | Gloves
| Upper body      | 21-Neurons Hub
|                 | USB cable
|                 | Body straps
|                 | Gloves
| Upper body      | 6-Neurons Hub
|                 | USB cable
|                 | Body straps
|                 | Gloves

![Diagram of upper body sensor placement](https://neuronmocap.com)
5.1.4 Lower Body Mode

Lower Body（Required sensors: Hip, both legs’ upper leg and lower leg.）

<table>
<thead>
<tr>
<th>Lower body</th>
<th>7-Neuron Hub</th>
<th>USB cable</th>
<th>Body straps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower body</td>
<td>5-Neuron Hub</td>
<td>USB cable</td>
<td>Body straps</td>
</tr>
</tbody>
</table>

5.2 Standby Device

Extra 1 and Extra 2 are standby devices. When there are some issues in the upper arms, upper legs, lower legs or feet connections, you can use Extra 1 or Extra 2 to replace the connection in question. These two extra devices can be used at the same time.
FAQs:

1. Condition: Using the extra device as the right upper arm in a 3-Neuron single arm mode. When establishing the connection with the client, the system will check the position of the candidate sensors and prompt you whether they are mapped in the right place. If not, you can drag it to the right position.
2. Condition: Extra 1 and Extra 2 used together in a 28-Neuron upper body mode with positions at right upper arm and left upper arm. This scenario will generate the same prompt dialog.

3. Condition: Using the extra device as the left upper arm in a 30-Neuron single arm/upper body mode and no sensor at right upper leg. In this scenario, the system will automatically detect the extra device on the right upper leg to match Full body mode and you will need to drag it to the right position manually.
5.3 Attention

If the sensors that are detected by the system can not satisfy the necessary nodes of the corresponding working mode, the system will automatically set the working mode to any qualified working mode. If there is no matching working mode found, the system will inform you which necessary nodes are lacking sensors. The red spots show the positions that require sensor for the necessary nodes.
6. Data Editing

6.1 Model Alignment

You can adjust the following posture angle to accurately capture an actor’s motion and optimize 3D effect of the motion capture.

Yaw: Direction settings. This parameter is used for adjusting model direction. The default value is 0. The clockwise direction is positive and the counterclockwise direction is negative. The range is -180 degrees to +180 degrees.

1. Pitch: This parameter is the included angle between the sensor and the ground in vertical direction. Front is positive and back is negative. The range is -45 degrees to +45 degrees.
   a) Application: Optimizes the Contact effect. After posture calibration, the contact effect may be inaccurate. So you can use Pitch to adjust model’s posture.

2. Roll: This parameter is the angle between the sensor and the ground in the horizontal direction. Rightward is positive and leftward is negative. The range is -45 degrees to +45 degrees.

TIPS:
After completing the 4-steps posture calibration. If the model in the Workspace still has angle problem, you can adjust Pitch and Roll to correct the posture.

![Model Alignment interface]

Some Common Issues:
- If the model always has front-back incline after calibration, adjust the pitch before recording. (human shape and posture problem)
- When doing real-time recording, not enough time is spent doing the posture calibration carefully.
- Ignoring the calibration altogether. Although, you can use these tools to optimize the recorded motion data after recording.

Operation Examples:
- If the model leans back and the feet are not contacting the ground when walking forward:
  Solution: increase the Pitch value to make the model incline forward.
- If the model leans front and when walking backward the feet have difficulty contacting the ground:
  Solution: decrease the Pitch value to make the model incline backward.
- If the model leans right and the left foot is not contacting the ground.
  Solution: decrease the Roll value.
- If the model leans left and the right foot is not contacting the ground.
  Solution: increase the Roll value.
6.2 Body Size Manager

You can improve the data accuracy by adjusting the body size. In the Body Size Manager, you can create, store, import, export or edit the body size data. There are some default body size files in Help->Open folder->body size. You can choose from them or input the accurate body size data yourself. For real-time capturing, you should choose a body size that matches the actor’s real size before posture calibration.
1. Measure the actor’s dimensions: Reference 6.7 Body size measure.
2. Click Add body size

3. Name the new body size. Then input the data that you just measured.
4. After establishing real-time connection, the default body size is Male 170.

5. Click Body Dimension in the Sensor Map. Then choose the body size that you just made.

Additional:

1. You can change the body size when you replay the file. But this operation is not suggested. You will get better results by establishing proper body size settings before calibration.

2. If you change the Body size after calibration, you will need to calibrate again.

3. Import Body Size: Click in the Body Size Manager. You can import the existing body size file into Axis Neuron for use, however, the body size format needs match the existing format for optimum accuracy.

4. Export Body Size: Click in Body Size Manager to export a body size for later use.
6.3 Parameters

The Parameters window offers options for floor contact and joint characteristics.

1. **Joint stiffness**: Setting higher values makes the jointed bodies more difficult to be separated. The default value is 0.65 and if the body size is accurate, you can make it higher. And if the body size is not accurate, lowering this value can add some leeway.

2. **Step stiffness**: When the model is walking, the system will use a pattern recognition algorithm to determine the contact status between the feet and ground. The step stiffness value affects the speed of this status change. Larger values will plant the feet more firmly on the ground. Conversely, smaller values will allow the feet to slide more easily while still contacting the ground.

3. **Step constraint**: The contact sensitivity between the feet and ground. The bigger the value, the more likely the feet are to be pulled to the ground. The smaller the value, the easier the feet are to leave the ground. For example: if the actor is running, then the Step constraint should be higher since the feet are leaving the ground quickly. If the actor is moving his or her feet off the ground slowly, then a lower Step constraint value should be used so the algorithm does not try to keep the feet snapped to the ground, resulting in an unnatural movement.

4. **Anti-Mag**: If there are high magnetic fields present, the feet may experience rotational drift. Check this box to minimize this result.

5. **Ground constraint**: Check this when some parts of the actor’s body is contacting the ground.

6. **Ground height**: This parameter is used for avoiding the skeletons penetrate into the ground when the actor goes upstairs or downstairs.

7. **Foot lock**: If you are not satisfied with Step stiffness effect, you could check this. Then when the algorithm determines that the feet are contacting the ground, the displacement of the Z direction will be locked which can assist with the feet becoming stuck into the ground.
8. Contact points: Can be applied to the feet, hands, or hips.

- Feet contact: Ten contact points: 5 at the ball of the foot and 5 at the back of the foot.
- Hands contact: Contact points are at the palm.
- Hip contact: Contact points are at the caudal vertebra.

Tip:
When the motion requires the feet to leave the ground, you need to uncheck the feet contact points, then apply the Hip contact points. Set an appropriate fixed height for the Hip. Only a person’s posture is captured in this kind of condition, no displacement (translation of the skeleton). If you need a result that has both feet and hip contact posture, you can check Hip Contact and then uncheck Feet Contact. Then choose the Interval frame for the hip contact and click Recalculate Selected Frame.

- Hip height: The height of hip to ground.
- CoM acc threshold: This is a threshold value. This value judges whether the body is contacting the ground by the body’s center of gravity.
6.4 Smooth Factor

Usually, there are factors that influence the accelerated speed and acceleration of gravity when an actor wears the equipment sensors:

- Body shaking (yourself or some external factor)
- Sensor measurement error
- Strap slack (straps and body have relative displacement)

Those effects can be countered by the Smooth factor function.

1. Open a raw file.
2. Check **Enable** in Smooth Factor.
3. After you change the value in the Smooth factor settings, click **Apply** button.
4. Export the data.
6.5 Data Visualizer

You can visualize real-time-changing displacement and angle data for the body in this panel.

Operations:
1. Choose the data type.

2. Set the Curve mode.

3. Choose the part you want to visualize.
4. Choose the displacement or angle in plotting properties.

5. Play the raw file, you can check the real time data's change.
6.6 Contact Editing

The Neuron system has an abundance of optimized algorithms. You can use them to achieve an ideal contact result. You can adjust the effect by single frames or by interval frame values.

Caution:
- Once you start contact editing, do not adjust these parameters otherwise the previous operation will be invalid:
  a) Model Alignment: Yaw, Pitch, Roll
  b) Parameters: Joint stiffness, Step stiffness, Step constraint, Contact points
- When you are editing the \( n^{th} \) frame, it will influence all frames after \( N \). But it won’t influence the frames before \( N \). So, please try to avoid to editing the frame that before any edited frame.

1. System auto optimization - There are 10 levels of optimization. The default value is 2. When you turn it to 0, the system will cancel optimization.
   a) If you didn’t change the status of optimization, the status will default to a value of 2. (The auto optimization will take effect before you open the raw file). If you change the value after you open a raw file, you need to recalculate all frames. (Right-click Contact Editing module, then click Recalculate all frames.)

2. Contact Editing Window

   a) Black means the body is touching the ground, if the frame is grey then it means the body is not touching.
   b) L Hand: Left hand contact editing area.
   c) R Hand: Right hand contact editing area.
   d) L Foot: Left foot contact editing area.
   e) R Foot: Right foot contact editing area.
   f) Hip: Hip contact editing area.
   g) When the red ball on the ankles displays, this indicates the foot is touching the ground. When you are editing contact status, you need to check Feet Contact point.
3. Single frame editing

a) Eg: Make the 1539 frame right foot status from uncontacting to contacting.
   i. Method 1: Right-click frame 1539 and choose **Contact**.
   ii. Method 2: Use shortcut key. Move the pointer to frame 1539 and click **W**.
TIP:
When you are contact editing, you can widen the contact editing panel to alleviate errors. When you locate a frame you want to edit, you need to make sure that the pointer is still at the frame you want to edit after you right-click.

4. Interval frame editing
   a) Eg: Make the Interval frames right foot status from uncontacting to contacting.
   b) Right-mouse drag the frames area you want to modify, then click Contact.
   c) Caution: This operation has no shortcut keys.

5. Combine Step stiffness to optimize feet contacting
   a) Precondition: Contact Optimization Level value is set to the default of 2.
   b) Open raw file.
   c) Adjust step stiffness. Keep in mind that this step must be completed ahead of manually adjusting contact status. Referenced in 6.3 Parameters.
   d) Click Apply.
   e) Then you can adjust contact status of any frame and you don’t need to recalculate.
6.7 Body Size Measurement

The closer the body size data is in Neuron to the actor’s body size, the more accurate the motion capture data will be. You can add a new body size in the Body Size Manager. Then input the values you measure.

Tips: the unit of measurement is in centimeters.

1. Head
   Top of head to the line of up lip and earlobe.

2. Neck
   Line of up lip and earlobe to C7. (The 7th bone of spine)
3. **Body**

C7 to head of femur.

4. **Shoulder width**

Left rotation center of shoulder to right rotation center of shoulder.
5. Upper arm
Rotation center of shoulders to rotation center of elbow.

6. Forearm
Rotation center of elbow to rotation center of wrist.
7. Palm
Rotation center of wrist to the top of mid finger.

8. Hip width
Left head of femur to right head of femur.
9. **Upper leg**
   Head of femur to rotation center of knee.

10. **Lower leg**
    Rotation center of knee to ankle bump bones.
11. Heel height
Ankle to the ground. (If you are wearing shoes, this measurement is to the bottom of the shoes.)

12. Foot length
The actor’s shoes size.
7. Offline Recording and Prop Function

7.1 Offline recording

Perception Neuron supports a new way to record that eliminates the need for a router, computer and the Axis Neuron software application. The offline data can be imported to Axis Neuron from a SD card connected directly to the Perception Neuron Hub.

7.1.1 Status Definition

1. Connect the Power Bank to any USB port of Hub, the offline mode will be enabled.
2. When turn into offline mode, the buzzer will sound two times. (Normal mode will sound once) 
3. The Neuron Led will stay on when the file system of SD card is not FAT32.
4. The Neuron Led will stay on when the SD card is full.
5. The Neuron Led will stay on if pull out the SD card in offline mode, until pull up the SD card and reconnect the Power Bank.

7.1.2 Turn into Offline Mode

Hold down the red button and connect the Power Bank will turn into Offline Mode. After power on release the red button, the buzzer will sound two times. This means the Offline Mode is ready.

7.1.3 Calibrate and Record

1. Calibration
   - Press and hold the red button until the buzzer stops. Release the red button and wait around five seconds, the buzzer will sound to notify for calibration. (Sound three times slowly means prepare for calibration, then a rushing sound means calibrating) The calibration has four stages one by one: STEADY_POSE, A_POSE, T_POSE and S_POSE.
   - STEADY_POSE: Body keep still until the rushing sound finish.
When you are recording offline, you will need a power bank to supply power. And you need a micro SD card to store motion data.
   - A_POSE, T_POSE and S_POSE: Sound three times slowly means prepare for calibration. (Please make the corresponding actions) When in a rushing sound, please keep the action. The Neuron Led will keep flashing in 1Hz.
2. Record
   - After calibration, it will start to record automatically. All data will be stored in the SD card.
7.1.4 Stop Record

There are two ways to stop record:
1. Unplug the power bank
2. Press and hold black button

7.2 Offline Data Import

The offline data will be stored in the SD card with bin format. You can import them to a raw file and play them in the Axis Neuron application.
1. Open Axis Neuron and put the SD card into the card reader on the Hub. Plug the Hub into a USB port.
2. Click File->Import.
3. Choose the file name which you want to import. (Just choose the directory)
4. Click **Next** after you choose the file you want import.

5. Set the body size.
6. Set the wear combination mode.

7. Choose the path of the generated raw file.

8. The imported file can be played or edited in Neuron normally.

   **Caution:** Because the offline recording does not support Prop, so prop will not be imported into Axis
7.3 Prop Function

The Prop Function is designed to make the scene abundant. In the record mode, you could hold the prop sensor, or bind the sensor to object (a stick) to simulate sword, knife or something else.

Contact point: the center of rotation of the prop. Prop sensor may rotates around the contact point

Operations:
- Connect the prop tool cable with sensor to a spare socket on the body strap, this sensor will become a prop sensor. Also, the working mode must be Full body mode. When the prop sensor has been connected and detected by the Axis Neuron, the Prop Settings panel will be enabled.
- Select the parent location of prop from the drop-down list of Props binding. (The default of Props binding is RightHand) and Click Apply. Then, the prop will show up in the 3D view area as a cube.
c. **Check the Checkbox** Show manipulator of Adjust contact point to show the manipulator of contact point controller in the 3D view area. The contact point locates at the center of cone bottom surface, Prop’s position should be on the blue ray that perpendicular to the bottom surface of the Cone.

Then you can adjust the spatial position of the contact point by left/right drag an axis of the manipulator (axis selected will turn yellow)
d. **Check the Checkbox Show manipulator** of Adjust props geometry to show the manipulator of Prop controller in the 3D view area.

![Prop Settings](https://neuronmocap.com)

e. Select one surface of the Prop manipulator, then press and hold the left mouse button to move the spatial position of the prop, also if the green corner of the Prop manipulator is selected one can scale the prop and select the ring can rotate the prop (when the border line/green corner/ring is selected, it will turn yellow).
f. To take effect of all above settings, please click **Apply**.

g. Click **Reset** props space gesture, spatial location and shape of the contact points will be restored to its original position.
h. Click **Remove** to remove current prop from the scene.
8. File Export and Data Transmission

8.1 File export

Axis Neuron can export data in BVH and FBX format file. Any software applications capable of reading these kinds of file formats can utilize motion capture data recorded through Perception Neuron.

8.1.1 BVH file export

1. Open raw file.
2. Click Export in the file menu.
3. Set BVH as the type to export in the Export Settings.
4. Click Export.
8.1.2 FBX file export

1. Open raw file.
2. Click **Export** in the file menu.
3. Set FBX as the type to export in the Export Settings.
4. Click Export.
8.1.3 3ds max biped file export

1. Open raw file.
2. Click Export in the file menu.
3. Set 3ds max as the type to export in the Export Settings.
4. Click Export.
8.1.4 Calculation File Export

The Axis Neuron system can export calculation file data. This data type includes bone posture quaternion in bone coordinate; displacement, speed in ground coordinate; original acceleration and gyro data in module coordinate.

1. Open raw file.
2. Click Export in the file menu.
3. Set Calculation as the type to export in Export Settings.
4. Click Export.
8.1.5 High-precision BVH file export

1. Open raw file.
2. Click Export in the file menu.
4. If you need the T-pose at the first frame or tail frame, you can choose it in Custom bvh.
5. Click Export.

Unavailable: No T-Pose at the first frame and tail frame.
Head Frame: A T-Pose before the first frame.
Tail Frame: A T-Pose after tail frame.
Head And Tail: Both T-Pose at the first frame and tail frame.
8.1.6 Multi-actor file export

1. Open raw file.
2. Click Export in the file menu.
3. Select the file type you want to export in the Export Settings.
4. Choose all the actors you want to export in your views.
5. Click Export.
8.2 Data transmission

Choose the content you want to transfer in File -> Settings -> Broadcasting. Axis Neuron supports BVH, Action, and Calculation data formats.
8.2.1 BVH

1. Advanced BVH

The used BVH data channel only supports simplex communication. There are some issues with used format including no abundant information and no downward compatibility. Therefore, there is a new format, Advanced BVH. It is built on Google’s Protobuf protocol and the channel can process two-way communication and has good downward compatibility.

We suggest you use this format. The protobuf protocol is

```protobuf
syntax="proto2";
option optimize_for = SPEED;
option cc_enable_arenas=false;
package AxisPlugs;
message BVH_VECTOR{
  required float X=1;
  required float Y=2;
  required float Z=3;
}
message BVH_JOIN{
  enum Channel {
    Xposition=0;
    Yposition=1;
    Zposition=2;
    Xrotation=3;
    Yrotation=4;
    Zrotation=5;
  }
  required string joinName=1;
  repeated Channel Channels=2;
  required BVH_VECTOR Offset=3;
  optional BVH_VECTOR EndSite=4;
  repeated BVH_JOIN ChildJoin=5;
}
message BVH_FRAME{
  repeated float MotionData=1;
  optional uint32 ActorTag=2;
  optional string ActorName=3;
}
message BVH_HEADER{
  required BVH_JOIN RootJoin =1;
  optional uint32 ActorTag =2;
  optional string ActorName =3;
}
message TAG_MAP_STRING{
  map<uint32,string> Map = 1;
}```
message ERROR_MESSAGE{
  required uint32 ErrorCode=1;
  required string ErrorMsg=2;
}

message COMMAND{
  enum CommandType{
    Notify_Characterised =1;
    Notify_Uncharacterised =2;
    Notify_ActorsList =3;
    Notify_Error =5;
    Command_Query_BVH_Header =6;
    Command_Query_ActorList =7;
    Command_ZeroOutActor =8;
  }
  required CommandType CmdType =1;
  oneof Content{
    uint32 ActorTag =2;
    TAG_MAP_STRING ActorsList =3;
    ERROR_MESSAGE ErrorMsg =4;
  }
}

message AXIS_PLUGIN_MESSAGE{
  enum MessageType{
    COMMAND =0;
    HEADER_DATA=1;
    FRAME_DATA=2;
  }
  required MessageType Message = 1;
  oneof Content{
    BVH_HEADER Header=2;
    BVH_FRAME Frame=3;
    COMMAND Command=4;
  }
}

Every frame data format:
{
  uint32 ------>start mark, 0x41414141 is source data, 0x43434343 is packed data
  uint32 ------>the data length
  data
}

If the data is packed data, we need to extract it and then analysis it with Protobuf. If the data is source data, you can analysis it directly. The packed data is in zip format. When another client connects with this channel, the Axis Neuron client will send a command of Notify_ActorsList to tell inform actor’s number and some another information. When another client connects with this channel, the Axis client will send BVH_FRAME uninterruptedly, BVH_HEADER needs
2. **BVH**

There are two ways: string or binary.

String is mainly used for downward compatibility. It is inefficient and the quantity of information is less. So we don’t suggest you use this format.

- The format of string:
  
  0 Avatar00 -17.80 99.86 -2.70 ... ||

  0 represent actor’s index.

  **Avatar00** represent actor’s name. The rest is this frame’s data.

  || means the tail of frame.

  Every frame’s data format is obtained from BVH headers. The easiest way to get the BVH headers is to export a BVH file according to current settings. Then get every frame by the BVH headers.

- The format of binary:

  It will send binary streams directly. Every frame will have headers and body data. So far, there are 2 versions: 1.0.0.3 and 1.1.0.0. You can check **use old header** to cut different headers. Here are the headers of two versions.

  // **DataVersion: 1.0.0.3**

  ```c
  struct _tagBVH_PIPE_DATA_FRAME
  {
    UINT16 BvhHeaderToken1; // Package start token: 0xDDFF
    DATA_VER DataVersion;   // Version of community data format. e.g.: 1.0.0.2
    UINT32 DataCount;       // Values count, 180 for without disp data
    INT32 WithDisp;         // With/out dispement
    INT32 WithReference;    // With/out reference bone data at first
    UINT32 AvatarIndex;     // Avatar index
    UINT8 AvatarName [32];  // Avatar name
    UINT32 Reserved1;       // Reserved, only enable this package has 64bytes length
    UINT32 Reserved2;       // Reserved, only enable this package has 64bytes length
    UINT16 BvhHeaderToken2; // Package end token: 0xEEFF
    float vMotionData [0];  // Motion data
  }
  ```

  // **DataVersion: 1.1.0.0**

  ```c
  struct _tagBVH_PIPE_DATA_FRAME_EX
  {
    UINT16 BvhHeaderToken1; // Package start token: 0xDDFF
    DATA_VER DataVersion;   // Version of community data format. e.g.: 1.0.0.2
    UINT16 DataCount;       // Values count, 180 for without disp data
    INT8 WithDisp;          // With/out dispement
    INT8 WithReference;     // With/out reference bone data at first
    UINT32 AvatarIndex;     // Avatar index
    UINT8 AvatarName [32];  // Avatar name
    UINT8 FrameIndex;
    UINT32 Reserved;
    UINT32 Reserved1;       // Reserved, only enable this package has 64bytes length
  }
  ```
8.2.2 Action

This is a motion identification channel. Just when some pattern's motion is triggered, this channel will have data. The definition of this format:

```c
// Action Recognition data
typedef struct _ActionRecognitionData
{
    ActionRecognitionDataTypes DataType;    // Type of action
    int DataLength;  // Data length
    int TotalLength; // Total length
    void* DataPtr;   // Address of data, always be the next address of 'DataPtr'
}ActionRecognitionData;
```

// Recognized action data types
typedef enum _ActionRecognitionDataTypes
{
    Action_SingleTapping,       // Hand single tapping
    Action_DoubleTapping,       // Hand double tapping
    Action_Fire,                // Fire
    Action_InwardFlipping,      // Hand in-ward flipping
    Action_OutwardFlipping,     // Hand out-ward flipping
    Action_MassVector,          // Vector data of center of gravity
    Action_SwingVector,         // Vector data of body swing
    Action_Unknown,             // Unknown type
}ActionRecognitionDataTypes;
```
8.2.3 Calculation

This channel’s data is obtained from calculations. It has string and binary formats.

- **String format:**

<table>
<thead>
<tr>
<th>01-X-x</th>
<th>01-X-y</th>
<th>01-X-z</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-V-x</td>
<td>01-V-y</td>
<td>01-V-z</td>
</tr>
<tr>
<td>01-Q-x</td>
<td>01-Q-y</td>
<td>01-Q-z</td>
</tr>
<tr>
<td>01-A-x</td>
<td>01-A-y</td>
<td>01-A-z</td>
</tr>
<tr>
<td>01-W-x</td>
<td>01-W-y</td>
<td>01-W-z</td>
</tr>
<tr>
<td>02-X-x</td>
<td>02-X-y</td>
<td>02-X-z</td>
</tr>
<tr>
<td>02-V-x</td>
<td>02-V-y</td>
<td>02-V-z</td>
</tr>
<tr>
<td>02-Q-x</td>
<td>02-Q-y</td>
<td>02-Q-z</td>
</tr>
<tr>
<td>02-A-x</td>
<td>02-A-y</td>
<td>02-A-z</td>
</tr>
<tr>
<td>02-W-x</td>
<td>02-W-y</td>
<td>02-W-z</td>
</tr>
<tr>
<td>03-X-x</td>
<td>03-X-y</td>
<td>03-X-z</td>
</tr>
<tr>
<td>03-V-x</td>
<td>03-V-y</td>
<td>03-V-z</td>
</tr>
<tr>
<td>03-Q-x</td>
<td>03-Q-y</td>
<td>03-Q-z</td>
</tr>
<tr>
<td>03-A-x</td>
<td>03-A-y</td>
<td>03-A-z</td>
</tr>
<tr>
<td>03-W-x</td>
<td>03-W-y</td>
<td>03-W-z</td>
</tr>
<tr>
<td>04-X-x</td>
<td>04-X-y</td>
<td>04-X-z</td>
</tr>
<tr>
<td>04-V-x</td>
<td>04-V-y</td>
<td>04-V-z</td>
</tr>
<tr>
<td>04-Q-x</td>
<td>04-Q-y</td>
<td>04-Q-z</td>
</tr>
<tr>
<td>04-W-x</td>
<td>04-W-y</td>
<td>04-W-z</td>
</tr>
<tr>
<td>05-X-x</td>
<td>05-X-y</td>
<td>05-X-z</td>
</tr>
<tr>
<td>05-V-x</td>
<td>05-V-y</td>
<td>05-V-z</td>
</tr>
<tr>
<td>05-Q-x</td>
<td>05-Q-y</td>
<td>05-Q-z</td>
</tr>
<tr>
<td>05-A-x</td>
<td>05-A-y</td>
<td>05-A-z</td>
</tr>
<tr>
<td>05-W-x</td>
<td>05-W-y</td>
<td>05-W-z</td>
</tr>
<tr>
<td>06-X-x</td>
<td>06-X-y</td>
<td>06-X-z</td>
</tr>
<tr>
<td>06-V-x</td>
<td>06-V-y</td>
<td>06-V-z</td>
</tr>
<tr>
<td>06-Q-x</td>
<td>06-Q-y</td>
<td>06-Q-z</td>
</tr>
<tr>
<td>06-W-x</td>
<td>06-W-y</td>
<td>06-W-z</td>
</tr>
<tr>
<td>07-X-x</td>
<td>07-X-y</td>
<td>07-X-z</td>
</tr>
<tr>
<td>07-V-x</td>
<td>07-V-y</td>
<td>07-V-z</td>
</tr>
<tr>
<td>07-Q-x</td>
<td>07-Q-y</td>
<td>07-Q-z</td>
</tr>
<tr>
<td>07-W-x</td>
<td>07-W-y</td>
<td>07-W-z</td>
</tr>
<tr>
<td>08-X-x</td>
<td>08-X-y</td>
<td>08-X-z</td>
</tr>
<tr>
<td>08-V-x</td>
<td>08-V-y</td>
<td>08-V-z</td>
</tr>
<tr>
<td>08-Q-x</td>
<td>08-Q-y</td>
<td>08-Q-z</td>
</tr>
<tr>
<td>08-A-x</td>
<td>08-A-y</td>
<td>08-A-z</td>
</tr>
<tr>
<td>08-W-x</td>
<td>08-W-y</td>
<td>08-W-z</td>
</tr>
<tr>
<td>09-X-x</td>
<td>09-X-y</td>
<td>09-X-z</td>
</tr>
<tr>
<td>09-V-x</td>
<td>09-V-y</td>
<td>09-V-z</td>
</tr>
<tr>
<td>09-Q-x</td>
<td>09-Q-y</td>
<td>09-Q-z</td>
</tr>
<tr>
<td>09-A-x</td>
<td>09-A-y</td>
<td>09-A-z</td>
</tr>
<tr>
<td>09-W-x</td>
<td>09-W-y</td>
<td>09-W-z</td>
</tr>
<tr>
<td>10-X-x</td>
<td>10-X-y</td>
<td>10-X-z</td>
</tr>
<tr>
<td>10-V-x</td>
<td>10-V-y</td>
<td>10-V-z</td>
</tr>
<tr>
<td>10-Q-x</td>
<td>10-Q-y</td>
<td>10-Q-z</td>
</tr>
<tr>
<td>10-W-x</td>
<td>10-W-y</td>
<td>10-W-z</td>
</tr>
<tr>
<td>11-X-x</td>
<td>11-X-y</td>
<td>11-X-z</td>
</tr>
<tr>
<td>11-V-x</td>
<td>11-V-y</td>
<td>11-V-z</td>
</tr>
<tr>
<td>11-Q-x</td>
<td>11-Q-y</td>
<td>11-Q-z</td>
</tr>
<tr>
<td>11-W-x</td>
<td>11-W-y</td>
<td>11-W-z</td>
</tr>
<tr>
<td>12-X-x</td>
<td>12-X-y</td>
<td>12-X-z</td>
</tr>
<tr>
<td>12-V-x</td>
<td>12-V-y</td>
<td>12-V-z</td>
</tr>
<tr>
<td>12-Q-x</td>
<td>12-Q-y</td>
<td>12-Q-z</td>
</tr>
<tr>
<td>12-W-x</td>
<td>12-W-y</td>
<td>12-W-z</td>
</tr>
<tr>
<td>13-X-x</td>
<td>13-X-y</td>
<td>13-X-z</td>
</tr>
<tr>
<td>13-V-x</td>
<td>13-V-y</td>
<td>13-V-z</td>
</tr>
<tr>
<td>13-Q-x</td>
<td>13-Q-y</td>
<td>13-Q-z</td>
</tr>
<tr>
<td>13-W-x</td>
<td>13-W-y</td>
<td>13-W-z</td>
</tr>
<tr>
<td>14-X-x</td>
<td>14-X-y</td>
<td>14-X-z</td>
</tr>
<tr>
<td>14-V-x</td>
<td>14-V-y</td>
<td>14-V-z</td>
</tr>
<tr>
<td>14-Q-x</td>
<td>14-Q-y</td>
<td>14-Q-z</td>
</tr>
<tr>
<td>14-W-x</td>
<td>14-W-y</td>
<td>14-W-z</td>
</tr>
<tr>
<td>15-X-x</td>
<td>15-X-y</td>
<td>15-X-z</td>
</tr>
<tr>
<td>15-V-x</td>
<td>15-V-y</td>
<td>15-V-z</td>
</tr>
<tr>
<td>15-Q-x</td>
<td>15-Q-y</td>
<td>15-Q-z</td>
</tr>
<tr>
<td>15-W-x</td>
<td>15-W-y</td>
<td>15-W-z</td>
</tr>
</tbody>
</table>

**Eg:** Body ID is 01 and body’s displacement(X)’s three channels(x, y, and z) description:

```
01-X-x 01-X-y 01-X-z
```

All the data types:

- **World coordinate displacement:** X (X, Y, Z), unit is meter.
- **World coordinate displacement:** V (X, Y, Z), unit is meter per second.
- **World coordinate module's posture data:** Q (W, X, Y, Z).
- **Module coordinate accelerated speed:** A (X, Y, Z), unit is g.
- **Module coordinate accelerated speed:** M (X, Y, Z), unit is radian per second.

**Bone mappings as follows**

```
01  Hips
02  RightUpLeg
03  RightLeg
04  RightFoot
05  LeftUpLeg
06  LeftLeg
07  LeftFoot
08  RightShoulder
09  RightArm
0A  RightForeArm
0B  RightHand
0C  LeftShoulder
0D  LeftArm
0E  LeftForeArm
0F  LeftHand
10  Head
```
- Binary format:
  
  ```
  struct _tagQVX_PIPE_DATA_FRAME
  {
    USHORT HeaderToken1;     // Package start token: 0xDDFF
    DATA_VER DataVersion;    // Version of community data format. e.g.: 1.0.0.2
    USHORT DataCount;        // Values count
    USHORT AvatarIndex;      // Avatar index
    USHByteArray AvatarName[32];   // Avatar name
    USHORT Reserved1;        // Reserved, only enable this package has 64bytes length
    USHORT Reserved2;        // Reserved, only enable this package has 64bytes length
    USHORT Reserved3;        // Reserved, only enable this package has 64bytes length
    USHORT Reserved4;        // Reserved, only enable this package has 64bytes length
    USHORT HeaderToken2;     // Package end token: 0xEEFF
  } _tagQVX_MOTION_SEGMENT vMotionData [0];
  ```

  ```
  struct _tagQVX_MOTION_SEGMENT
  {
    USHByteArray displacement [3];
    USHByteArray velocity [3];
    USHByteArray quaternion [4];
    USHByteArray acceleration [3];
    USHByteArray gyroscope [3];
  }
  ```
8.2.4 IP selected

Axis Neuron client uses TCP/UDP to send body motion data. It can be read on a local computer or another computer via the Internet.

1. TCP
   a) Select TCP in File -> Settings -> Broadcasting. The Host Address choose Axis Neuron Host IP.
   
   ![Settings window with TCP option selected]

   b) Select transmission type, like BVH binary, and set the port.

   ![Advanced settings window with BVH options and ports configured]
c) Click **OK**.
d) Open the third-party client, then input Axis Neuron’s Host IP in Server IP, then input the port number, then click **Connect**.
e) After connection, open the raw file in Axis Neuron.

2. **UDP**
   a) Local computer transmission
b) Select UDP in File -> Settings -> Broadcasting. Choose 127.0.0.1 in Host Address.

c) Select data type, like BVH binary, set the port. Then click Add button, input 127.0.0.1 or 255.255.255.255. Local computer must add Client IP address and inform a different port number with data channel.

d) Click OK button.

e) Open another client, set the port to 8888.

f) Open raw file in Axis Neuron or build real time connection with equipment.

3. Transfer to another computer

   a) Select UDP in File -> Settings -> General, choose Axis Neuron’s host IP but can’t be 127.0.0.1.
      b) Choose the data type, like BVH binary, and set the port.
      c) Click Add button, add another client’s address or input 255.255.255.255.

      If the third-party’s client is not in the same computer with Axis Neuron, you can define the port number. Input the port number you defined in the address panel; if not, input behind the data type port number.
Port: 8888

Port: 7001
The host IP must in the same LAN.

a. Click **OK**.
b. Start another client, set the port in Axis Neuron.
c. Build real time connection.
9. Equipment Maintenance

9.1 Device Firmware upgrade

The hardware and software systems support both the Hub and Neuron upgrade together. When the Hub and Neuron need to be upgraded, the Hub will be upgraded first. There is also support for upgrading the Hub or Neuron independently. When the Hub does not connect to the Neuron client, a dialogue will display, you just need to click **Only Hub upgrade**.

Needed-upgrade firmware will show in a red light. And normal firmware will show in a green light.

1. Hub and Neuron upgrade together:
   a) Connect the Hub and computer via USB. The Hub side needs to be plug into the Data port.
   b) Launch Axis Neuron, choose **Upgrade** in the Tool menu.
   c) Click **Connect** in the Equipment list.
d) Click the Upgrade button.

Tips:
If all lights are green, it indicates that the equipment doesn’t need to be upgraded, you can close it directly.
e) Click Yes.

f) It will upgrade the Hub first then upgrade the Neuron devices. There will be some buzzing after Hub upgraded successfully. Then the lower version sensor will be upgraded. There also will be a tone sound after each sensor upgraded successfully. The corresponding light will turn to green.
2. Hub upgrade only:
   a) Connect Hub and computer with USB. Hub side need to be plug into Data port.
   b) Launch Axis Neuron, choose Upgrade in tools menu.
   c) Click Connect button in Equipment list.

   g) Close the Upgrade window.
d) Click Only Hub upgrade button.

Click Yes button
9.2 Neuron calibration

After a long time of usage, the sensors might accumulate some calculation errors. This will cause posture problems such as drifting. To remedy this, you can install the sensor into the prop tool cable, then go to client to calibrate it.

1. Calibrate sensor directly with prop tool cable.
   a) Launch Axis neuron.
   b) Click **Calibrate sensor** in the Tools menu.
   c) Put the sensor into the prop tool cable and connect the line with the Hub. Then click **Next**.
d) Click **Connect** in the Equipment list.

e) Click **Next**.
f) After Steady pose, move the sensor. The model in the client will show sensor’s posture. If the posture is drifting, this indicates that the Sensor is magnetized and that you need to calibrate it. Click **Next**.
g) Click **Next**.

![Calibrate sensor](https://neuronmocap.com)

h) Click **OK**.
i) Click OK

j) There are 2 optional ways to calibrate. You could click the video to get it.
k) Click next when the video is done.
l) Start rotating the sensor like the videos. The green points show the collected data.

m) When this process reaches 100 percent, the hub will start buzzing. Click **next to end calibration.**
n) After calibration, you can check the posture of the sensor, you can do a calibration again if you are not satisfied with the sensor posture. Click **Next Sensor** to do it again or calibrate another sensor.

2. Calibrating sensor in real-time mode - The basic operation is the same as calibrating the sensor directly with the prop tool cable. When calibration is complete, there will be a message that will ask you if you want to go back to motion capture mode. If you want, reconnect the capture device, by clicking **Yes**.
10. Appendix

1. Storage of equipment
The Neuron sensor box is made of special antimagnetic silicon steel material. It keeps the sensors from becoming magnetized by the environment. We suggest that you put the sensors into this box when doing long distance transfers, long term storage, or exposure to strong magnetic field environments. And we also suggest you keep away from the following devices when you are recording.
   a) electrical machine or generator (3 feet)
   b) any magnet or electrical magnet (3 feet)
   c) power box or high-tension line.(6 feet)
   d) loudspeaker box, refrigerator, compressor, A/C Unit (3 feet)
   e) computer, keyboard, mouse, Earphone, TV

2. Common questions
   a) Cover install Axis Neuron, failed to launch.
      i. Solutions:
         1. Run Axis_Neuron_CLEAN.bat  
            to clean Noitom registry or do it manually. (Path in registry is HKEY_CURRENT_USER —>Software —>Noitom.)
         2. Delete higher version raw file in Noitom\Axis Neuron\Motion Files. Lower versions of Axis Neuron system may not analysis higher versions raw file.
         3. Reinstall. Click Repair then install it.

Tip: If it is not necessary, don’t use lower versions to cover higher versions. And please backup the registry before you clean it.
b) When connecting the device with the client, Axis Neuron always displays a No sensor found dialog and all the BLN is in standby status.

![Image of an error dialog with text: There is no sensor found. Check the Equipment and retry!]

i. Solution:
1. If you are using single arm mode, it is likely that the two side lines of the Hub have poor contact. Please change to a new line and try to reconnect.
2. If you are using full-body mode, you can use dual pogo-pin cable instead the main line of hip, one side connect shoulder and one side connect Hub. Reconnect Hub with client, if successful, that indicates the main line of hip and Hub has poor contact or is broken, please contact after sale.
3. If in Wireless mode, when opening a connection, if you accidentally pull out the line from the Hub 5V/2A port, power off and repower up. If the Hub LED is 5HZ flashing, click the connect button in the Equipment list. If connect fails, it might be instability of the internet.
4. If all of the methods fail, please change a Hub.

3. When firmware is upgraded, some LEDs on the sensors show 0.3HZ slow flashing status.
   a) Solutions:
       i. Plug the sensor related to the LED in the prop tool cable and connect to the Hub. Upgrade it in Tool -> Upgrade. Click Connect in equipment list, select the second option in the Upgrade Mode dialog and click Next, then the LED should be in normal status after upgrading process, this Neuron can then be used.
4. The fingers sensor is always disconnected in real-time and the LED changes to standby status in 31-Neuron Full body mode.
   a) Solutions:
      i. Find a portable power source and plug in 5V/2A port. (Because the laptop might not be able to afford the electricity that the Hub needs. When using more than 18 sensors, we suggest using a portable power source.)

5. Capturing upstairs motion
   a) Measure the height of the stairs. When in real-time mode, set the Ground height to a specified value, then uncheck Ground constrain.

   b) When you play these files, uncheck feet as Contact points.
6. When completing posture calibration, the S-pose or T-pose can not be selected.

a) Solution: Only Lower body or Full body mode requires S-pose calibration. In that same regard, lower body mode does not require an A-pose calibration. If you need the motion of arms, please choose a corresponding mode.

7. Hardware light instruction
   a) Sensor indicator light status:
b) Hub indicator light status:

<table>
<thead>
<tr>
<th>LED Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>90% Flashing</td>
<td>Connecting to WiFi or server PC</td>
</tr>
<tr>
<td>Blinking</td>
<td>Standby mode</td>
</tr>
<tr>
<td>20% Flashing</td>
<td>Working mode</td>
</tr>
<tr>
<td>Quick flash 3 times and off for 5s</td>
<td>Sleeping mode</td>
</tr>
<tr>
<td>3.5 Hz slow flash</td>
<td>Firmware update mode</td>
</tr>
<tr>
<td>Other status</td>
<td>Hub malfunction</td>
</tr>
</tbody>
</table>

Tips:
You can find this in the last two pages of Help --> Quick Start Guide.